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Summary 28 

The objective of this protocol is to use molecular dynamics simulations to examine the 29 

dynamic structural changes that occur due to activating mutations of the EGFR kinase protein.  30 

 31 

Abstract 32 

Numerous somatic mutations occurring in the epidermal growth factor 33 

receptor (EGFR) family (ErbB) of receptor tyrosine kinases (RTK) have been reported from 34 

cancer patients, although relatively few have been tested and shown to cause functional 35 

changes in ErbBs. The ErbB receptors are dimerized and activated upon ligand binding, and 36 

dynamic conformational changes of the receptors are inherent for induction of downstream 37 

signaling. For two mutations shown experimentally to alter EGFR function, A702V and 38 

the ΔELREA deletion mutation, we illustrate in the following protocol how molecular 39 

dynamics (MD) simulations can probe the (1) conformational stability of the mutant tyrosine 40 

kinase structure in comparison with wild-type EGFR; (2) structural consequences and 41 

conformational transitions and their relationship to observed functional changes; (3) effects 42 

of mutations on the strength of binding ATP as well as for binding between the kinase 43 

domains in the activated asymmetric dimer; and (4) effects of the mutations on key 44 

interactions within the EGFR binding site associated with the activated enzyme. The protocol 45 

provides a detailed step-by-step procedure as well as guidance that can be more generally 46 
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useful for investigation of protein structures using MD simulations as a means to probe 47 

structural dynamics and the relationship to biological function.  48 

 49 

Introduction: 50 

The human epidermal growth factor receptor (EGFR) family (ErbB) of receptor tyrosine 51 

kinases (RTKs) includes four members – EGFR/ErbB1/HER1, ErbB2/HER2, ErbB3/HER3 and 52 

ErbB4/HER4. The ErbB receptors regulate fundamental cellular processes such as cell growth 53 

and proliferation, differentiation, migration and survival1,2, and are thus potent proto-54 

oncogenes. Aberrant activity of the ErbB receptors, especially EGFR and ErbB2, has been 55 

frequently associated with human cancers making ErbB receptors key targets for cancer 56 

therapeutics2,3. 57 

 58 

Several somatic alterations of ERBB genes have been reported from human malignancies3,4,5. 59 

The best characterized examples include the recurrent, activating point mutations and short 60 

in-frame deletions in the EGFR kinase domain in non-small cell lung cancer (NSCLC). These 61 

EGFR mutations represent key drivers of cancer growth, and predict sensitivity to EGFR 62 

targeting cancer drugs6,7,8. However, in most cancers, somatic mutations in EGFR occur 63 

outside of these recurrent “hotspots” and are distributed over the entire 1210-residue span 64 

of the receptor. Indeed, most of the residues along the EGFR primary sequence have been 65 

found to be mutated in human cancer9. Nevertheless, apart from the few hotspots, the 66 

functional significance of the vast majority of the cancer-associated EGFR mutations remains 67 

unknown. 68 

 69 

The monomeric structure of ErbBs consists of a large amino terminal extracellular domain, 70 

followed by a single transmembrane helix leading to the intracellular tyrosine kinase domain 71 

and C-terminal tail region that contains docking sites for intracellular signaling proteins. 72 

Ligand binding triggers a dramatic conformational change in the extracellular domain, which 73 

facilitates the formation of receptor dimers by exposing the dimerization arms that 74 

symmetrically cross over each other and interact with their aromatic/hydrophobic surfaces. 75 

Upon receptor dimer formation the tyrosine kinase domains come into contact 76 

asymmetrically (Figure 1), resulting in the activation of the kinases that phosphorylate the C-77 

terminal tails of the receptor monomers, and subsequently in activation of downstream 78 

signaling10, 11. 79 

 80 

 [Place Figure 1 here] 81 

 82 

Because of the dynamic structural rearrangements that occur during the monomer ⇄ dimer 83 

transitions, along with kinase activation that is associated with the formation of an 84 

asymmetric dimer, mutations along the full length of the receptor structure can potentially 85 

have an effect on receptor function. Here we describe several examples from our previous 86 

studies in which modeling of the mutation and visualization were sufficient to explain the 87 

consequences for function. 88 

 89 

Example 1: One reported mutation, D595V in ErbB413, led to increased ErbB4 dimerization 90 

and phosphorylation14. Visualization of the location of the mutation was a critical factor in 91 

understanding the observed functional effects: D595V occurred at the symmetrical crossover 92 

of the dimeric arms of the ectodomain (Figure 2A). The arms are largely aromatic and 93 



hydrophobic, and the replacement of polar aspartic acid by valine would be expected to 94 

increase the “sticky” hydrophobic interactions, stabilizing the dimer and hence increase the 95 

length of time when phosphorylation takes place14. It was a surprise at first to find aspartate 96 

in each arm, but in retrospect one might think of it as a timing mechanism for activity, where 97 

the polar acid side chains reduce the affinity and lifetime of the intact dimer and hence limit 98 

kinase-mediated phosphorylation and signaling. Replacement by valine would then remove 99 

this safeguard by further stabilizing the ErbB4 dimer. 100 

 101 

[Place Figure 2 here] 102 

 103 

Example 2: One might anticipate that somatic mutations that target the ATP-binding site of 104 

the kinase domain would alter or eliminate enzymatic activity leading to an impaired or 105 

kinase-dead receptor incapable of signaling. Of nine reported mutations from patients with 106 

breast, gastric, colorectal, or NSCLC15, two of the nine mutations when tested had highly 107 

diminished phosphorylation activity16: G802dup (G → GG) and D861Y. Both inactivating 108 

somatic mutations were found within the ATP binding site of the tyrosine kinase domain 109 

structure (Figure 2B): flexible glycine, duplicated, would alter the adenine ring site and small 110 

aspartic acid replaced by the bulky tyrosine near the terminal phosphates would physically 111 

prevent Mg2+–ATP from binding. However, since ErbB4 can form a heterodimer with ErbB2 – 112 

ErbB2 does not bind a growth factor and depends on association with an ErbB that does in 113 

order to heterodimerize – the ErbB2(active)-ErbB4(kinase-dead) heterodimer would 114 

stimulate cell proliferation via the Erk/Akt signaling pathway yet cells would not differentiate 115 

because of kinase-dead ErbB4 and lack of STAT5 pathway activation16. 116 

 117 

In more recent studies, it became apparent that the dynamic movements of ErbBs were 118 

relevant to understanding the effects of some mutants on ErbB function, especially mutations 119 

that occur within the tyrosine kinase domain. The tyrosine kinase domain consists of an N-120 

lobe (mainly β-sheets) and C-lobe (largely alpha helical), which are separated by the catalytic 121 

site where ATP binds. The N-lobe includes the αC helix and P-loop, whereas the activation (A-122 

loop) and catalytic loops are present in the C-lobe17,18,19. Crystal structures of the tyrosine 123 

kinase domain revealed two inactive conformations, the majority of structures have the Src-124 

like inactive state. In the active conformation the catalytic aspartate of the A-loop points 125 

towards the ATP binding site and the αC helix is oriented towards the ATP binding pocket 126 

(“αC-in” conformation), forming a strong glutamate-lysine ion-pair interaction. 127 

 128 

Because ErbBs and the component kinase domain are highly dynamic entities, and especially 129 

for instances where the effects of mutations on function and biological activity are likely to 130 

be tightly linked to the conformational states of the ErbBs, it is important to assess mutations 131 

with respect to the range of dynamic changes they would experience. X-ray crystal structures 132 

of ErbBs provide static snapshots of the 3D structure, which may or may not be relevant to 133 

understanding the dynamic consequences of a mutation. In order to probe the range of 134 

dynamic changes corresponding to the “energy landscape” available to a three-dimensional 135 

(3D) structure, molecular dynamics (MD) simulations are widely used20. In the case of 136 

mutations that would lead to local conformational changes within the tyrosine kinase domain 137 

or stabilization of a complex, simulations on the order of 100 ns may be sufficient. However, 138 

larger scale conformational changes (e.g., transitions between the active and inactive 139 



conformations of the kinase domain) require a longer simulation time – on the order of 140 

microseconds21. 141 

 142 

With respect to the protocol described below we consider two activating mutations within 143 

the tyrosine kinase domain (Figure 3). Both mutations are located within the kinase domain 144 

at locations that experience local conformational changes that dictate whether the kinase is 145 

active or not, and thus MD simulations were applied in both instances. In the first case, we 146 

consider changes that directly affect the ATP binding site and catalytic machinery of the EGFR 147 

receiver kinase domain, specifically examining the consequences of an exon 19 deletion 148 

mutation that is widely implicated in NSCLC4,7. The Δ746ELREA750 mutation, which reduces the 149 

length of the β3-αC loop preceding the αC helix – the helix that moves towards the 150 

binding/active site on kinase activation and participates in forming the critical electrostatic 151 

interaction between E762 of the helix and K745 by positioning the lysine for interaction with 152 

ATP – predisposes the domain for activation12. In the second case, we consider the A702V 153 

mutation of EGFR, shown to be a novel gain-of-function activating mutation revealed by the 154 

iScream platform9 and identified in an NSCLC patient22. Alanine-702 on the receiver kinase 155 

domain is located on juxtamembrane segment B at the interface of the receiver and the 156 

activator kinase domains, in which this asymmetric kinase dimer complex and kinase 157 

conformational changes are required for activation9. 158 

 159 

[Place Figure 3 here] 160 

 161 

PROTOCOL 162 

 163 

NOTE: The detailed steps taken to examine the effects of the ΔELREA and A702V mutation on 164 

the EGFR structure using MD simulations are discussed as follows: 165 

 166 

1. Structure preparation 167 

 168 

NOTE: In order to study the structural impacts of the ∆ELREA mutation, wild-type and mutant 169 

forms of apo active, ATP-bound active and apo inactive EGFR monomer structures are 170 

prepared as follows.  171 

 172 

1.1. Open the Chimera23 visualization program (https://www.cgl.ucsf.edu/chimera/) to 173 

prepare the wild-type apo active EGFR kinase structure. In the File menu click the Fetch by ID 174 

option and select the Protein Data Bank (PDB24) database and specify PDB code 2GS225 (2.8 Å 175 

resolution). The PDB is a repository for 3D structures solved by different experimental 176 

techniques, including X-ray crystallography, nuclear magnetic resonance spectroscopy, cryo-177 

electron microscopy and neutron diffraction. 178 

 179 

1.2. Build the missing structural elements of 2GS2 by taking these segments from the EGFR 180 

PDB structures 1M1426 (2.6 Å) and 3W2S27 (1.9 Å). To do so, open 1M14 and 3W2S and 181 

superimpose them on 2GS2 using the MatchMaker option in the Tools → Structure 182 

comparison menu.  183 

 184 

1.2.1. Crop out the segments to be added from 1M14 and 3W2S. Select the terminal atoms 185 

of the residue before the gaps in 2GS2 and the atoms to be added from 1M14 and 3W2S (for 186 

https://www.cgl.ucsf.edu/chimera/


detailed information on the added segments, see Table 1). On the command line type bond 187 

sel and hit enter. This structure is the template structure. 188 

 189 

1.3. Use the template structure from step 1.2 to construct the ∆ELREA deletion mutant 190 

form of the EGFR kinase domain. Produce the FASTA format sequence of ∆ELREA EGFR by 191 

saving the sequence of the template structure (Favorite → Sequence → File → save as) and 192 

then deleting the ELREA sequence at residue numbers 746-750.  193 

 194 

1.3.1. Open the ∆ELREA EGFR sequence in Chimera and align it with the sequence of the 195 

2GS2 template structure using the Sequence menu. In the alignment window select the 196 

Structure → Modeller (homology)28 option.  197 

 198 

1.3.2. On the pop-up window specify the 2GS2 composite structure as the template and the 199 

mutant sequence as the query to be modeled. Then press OK. Select a mutant model among 200 

the resulting models, based on the zDOPE score (typically the lowest score) and visual 201 

inspection.  202 

 203 

1.4. To prepare the ATP-bound wild-type EGFR kinase structure, use PDB structure 2ITX29 204 

(2.98 Å) as the principal structure. Build missing segments (see Table 1) using the structures 205 

2GS625 (2.6 Å) and 3W2S following the procedure in step 1.2. Convert the ligand ANP in the 206 

resulting structure to ATP by opening the PDB file in a text editor and changing the N3B 207 

nitrogen atom of ANP to an oxygen atom.  208 

 209 

1.5. Open the structure in step 1.4 in Chimera as stated in step 1.1. Add a magnesium ion 210 

to this structure from PDB structure 2ITN29 (2.47 Å) in order to attain a similar positioning for 211 

the Mg2+ ion. 212 

 213 

1.6. With the structure resulting from step 1.5, model the ∆ELREA mutant form following 214 

the step 1.3. 215 

 216 

1.7. To prepare the wild-type apo inactive EGFR kinase structure, open PDB structure 217 

2GS725 (2.6 Å) as in step 1.1 and delete the bound ligands and crystallographic waters. Add 218 

the missing segments in 2GS7 (see Table 1) from structures 3W2S and 4HJO30 (2.75 Å) using 219 

the procedure in step 1.2. Based on the final inactive EGFR structure, prepare the mutant 220 

model using the procedure in step 1.3. 221 

 222 

NOTE: For the A702V mutation study, the EGFR asymmetric dimer structure is studied as the 223 

mutation is located at the juxtamembrane B segment of the kinase domain that forms a large 224 

part of the dimer interface. The wild-type and A702V mutant EGFR structures are prepared 225 

as follows: 226 

 227 

1.8. The wild-type asymmetric dimer structure is constructed from PDB structure 2GS2, 228 

which initially is displayed in the monomeric form. To convert to the biological assembly that 229 

contains the activator and receiver kinases in the asymmetric arrangement, open 2GS2 in 230 

Chimera as in (1.1) and carry out symmetry calculations by clicking the Tools → Higher-Order 231 

Structure → Unit Cell menu. Select the 2GS2 structure and enter Make copies. Finally, select 232 



and save a single asymmetric dimer from the multiple copies of the dimer resulting from the 233 

symmetry operations. 234 

 235 

1.9. Using the wild-type asymmetric EGFR structure from step 1.8, build the A702V mutant 236 

by replacing alanine 702 with valine using the Tools → Structure editing → Rotamers option 237 

in Chimera. 238 

 239 

NOTE: Collectively, six monomeric and two dimeric EGFR structures are prepared for the 240 

∆ELREA and A702V mutation studies, respectively. Each structure is subsequently processed 241 

for simulation using the protein preparation wizard in the Maestro program31 and MD 242 

simulations are made with the Amber program32. 243 

 244 

1.10. Open the structure in Maestro by using the File → import structure option. Then click 245 

on the protein preparation wizard button and select the following: add hydrogen atoms, 246 

build missing side-chain atoms, determine protonation states of ionizable residues at pH 7.0 247 

using PROPKA, optimize the orientation of asparagine, glutamine and histidine residues for 248 

hydrogen bonding, and finally minimize the structure. 249 

 250 

2. System setup 251 

 252 

2.1. Open the leap program included in the Amber software package. Import the ff14SB 253 

force field33 (source leaprc.protein.ff14SB) and TIP3P water molecules34 (source 254 

leaprc.water.tip3p). For the ATP-bound systems also import parameters for ATP35 255 

(loadamberparams frcmod.phosphate, loadamberprep ATP.prep). Then, load the structure 256 

(mol = loadpdb structure.pdb). 257 

 258 

2.2. Solvate the structure in an octahedral box with explicit TIP3P water molecules that 259 

extends 10 Å in all directions from the surface atoms of the protein (solvateoct mol TIP3PBOX 260 

10.0). 261 

 262 

2.3. Check the built system (Check mol) and neutralize it by adding necessary ions (addions 263 

mol Na+ 0). To sufficiently model biomolecular systems, add additional Na+/Cl- atoms to the 264 

simulation box to bring the system salt concentration to 0.15 M (addions mol Na+ X, addions 265 

mol Cl- X), where X is replaced by the result of: desired salt concentration * number of water 266 

molecules * volume per water molecule * Avogadro’s number. 267 

 268 

2.4. Generate and save the topology and coordinate files of the system, which serve as 269 

inputs for the subsequent production simulation (saveamberparm mol X.prmtop X.inpcrd). 270 

 271 

3. Molecular dynamics simulation 272 

 273 

3.1. Using Amber, initially subject the simulation system to 5000 cycles of steepest descent 274 

and conjugate gradient energy minimization to circumvent unfavorable configurations. Carry 275 

out the minimization in multiple steps, gradually lowering the restraint applied on solute 276 

atoms from 25 mol−1 Å−2 to 0 kcal mol−1 Å−2.  277 

 278 



3.1.1. In the minimization input file, min.in, adjust the maxcyc variable for the total 279 

minimization cycle (maxcyc = 5000) and ncyc to state the number of cycles for the steepest 280 

descent algorithm. Use the restraint_wt variable to apply the restraint force on solute atoms 281 

specified by the restraintmask parameter. Then run the minimization as follows: 282 

$AMBERHOME/bin/sander -O -i min.in -o min.out -p X.prmtop -c X.inpcrd -r min.rst -ref 283 

X.inpcrd 284 

 285 

NOTE: The strategy and actual parameters used may vary according to one’s own preferences. 286 

Details and guidance can be found from the Amber manual and website 287 

(https://ambermd.org/index.php). 288 

 289 

3.2. Heat the system for 100 ps from 0 K to 300 K setting a 10 kcal mol−1 Å−2 restraint on 290 

solute atoms. To do so, set tempi = 0.0, temp0 = 300.0, dt = 0.002 ps, nstlim = 50000 and 291 

restraint_wt = 10 in the heat.in input file. Carry out the heating with the following command: 292 

$AMBERHOME/bin/sander -O -i heat.in -o heat.out -p X.prmtop -c min.rst -r heat.rst -x 293 

heat.mdcrd -ref min.rst 294 

 295 

3.3. Equilibrate the system for 900 ps under an NPT ensemble; constant number of atoms, 296 

temperature (temp0 = 300.0) and pressure (ntp = 1), controlling it with the Berendsen 297 

method (ntt = 1). Set a 9 Å distance cutoff (cut = 9.0) for long range electrostatic interactions. 298 

Gradually lower the solute atom restraint to 0.1 mol−1 Å−2 (restraint_wt = 0.1). Run the 299 

equilibration input file equil.in that describes the above parameters as follows: 300 

$AMBERHOME/bin/sander -O -i equil.in -o equil.out -p X.prmtop -c heat.rst -r equil.rst -x 301 

equil.mdcrd -ref heat.rst 302 

 303 

3.4. Finalize the equilibration with an unrestrained 5 ns simulation (set dt = 0.002 ps, 304 

ntslim = 2500000). 305 

$AMBERHOME/bin/sander -O -i equil_final.in -o equil_final.out -p X.prmtop -c equil.rst -r 306 

equil_final.rst -x equil_final.mdcrd -ref equil.rst 307 

 308 

3.5. Check that the system has equilibrated by examining the temperature, pressure, 309 

density and energy values. 310 

$AMBERHOME/bin/process_mdout.perl heat.out equil.out equil_final.out 311 

xmgrace summary.TEMP/DENSITY/ETOT/EPTOT/EKTOT 312 

 313 

3.6. Carry out the production simulation for 100 ns (set dt = 0.002 ps, ntslim = 50000000 314 

in prod.in) and save conformations every 10 ps (ntwx = 5000). 315 

$AMBERHOME/bin/sander -O -i prod.in -o prod.out -p X.prmtop -c equil_final.rst -r prod.rst 316 

-x prod.mdrcd -ref equil_final.rst 317 

 318 

4. Analysis 319 

 320 

4.1. Visual inspection 321 

 322 

4.1.1. Visualize the conformations sampled during the wild-type and mutant EGFR kinase 323 

simulations by opening the X.prmtop amber topology files and the corresponding 324 

prod.mdcrd trajectory files in VMD36. Using convenient secondary structure representations, 325 

https://ambermd.org/index.php


analyze the overall structural dynamics of the proteins from the recorded trajectory. View 326 

specific interactions between atoms/residues of interest, such as the catalytically essential 327 

K745 — E762 salt bridge. 328 

 329 

4.1.2. Alternatively, save multiple conformations sampled during the simulation in PDB 330 

format and open them using the Chimera program. Superimpose the structures on the initial 331 

or median structure using the MatchMaker option. Display the initial/median structure in 332 

solid and the rest of the aligned structures in faded white. This approach allows one to 333 

visualize the recorded structural movements with more clarity.  334 

 335 

NOTE: Suggestions for effective representations and processing of conformational ensembles 336 

from MDS can be found in Melvin et al.37. 337 

 338 

4.2. RMSD and RMSF analysis 339 

 340 

4.2.1. Compute root-mean square deviation (RMSD) and root-mean square fluctuation 341 

(RMSF) calculations with the Cpptraj program38 to analyze the global stability of the proteins 342 

and examine the flexibility of the different structural units. In the rmsd.in and rmsf.in input 343 

files, indicate the backbone atoms (for RMSD) and Cα atoms (for RMSF) of the initial structure 344 

as the reference for RMS fitting. In the rmsd/rmsf.in files import the amber topology files 345 

(parm X.promtop) and the corresponding trajectory files (trajin prod.mdcrd). Then run the 346 

command Cpptraj -i rmsd/rmsf.in. Plot the output data for analysis. 347 

 348 

4.2.2. Alternatively, align conformational ensembles and color each residue based on the Cα 349 

atom RMSD. To do so, open the conformations in Chimera and align them with Matchmaker 350 

option.  351 

 352 

4.2.2.1. Go to Tools → Depiction → Render by attribute. Select Residues of the 353 

conformational ensemble and Cα RMSD as the attributes and click OK. The chain trace of the 354 

conformations will then be colored from blue → white → red, respectively reflecting regions 355 

of high, medium and low structural stability. 356 

 357 

4.3. Hydrogen bond analysis 358 

 359 

4.3.1. Analyze the hydrogen bond interaction between ATP and wild-type/∆ELREA EGFRs. 360 

Prepare a Cpptraj script, hbond.in, to carry out this task. Define a hydrogen bond with a 361 

donor-acceptor distance of less than or equal to 3.5 Å and a bond angle of greater than or 362 

equal to 135˚. Specify analysis only for intermolecular hydrogen bonds with the nointramol 363 

variable i.e. hydrogen bonds between ATP and EGFR (hbond All nointramol dist 3.5 out 364 

nhb.agr avgout avghb.dat). Run the script as Cpptraj -i hbond.in.  365 

 366 

4.3.2. Use this script to assess intramolecular interactions, for instance between residues 367 

K745 and E762, which are key residues for EGFR kinase activity. To do so, specify K745 as the 368 

hydrogen bond donor and E762 as the hydrogen bond acceptor in hbond.in and run the script 369 

accordingly. 370 

 371 

4.4. Monitoring distance between atoms 372 



 373 

4.4.1. Measure the distance between K745 and E762 by opening the trajectories of wild-type 374 

and ∆ELREA apo EGFRs in VMD. Select the Cδ of Glu762 and Nz of Lys745 by clicking Mouse 375 

→ label → bond. Monitor the distance during the simulation by plotting a graph with graphics 376 

→ labels → bond → graph. 377 

 378 

4.5. Free energy calculations 379 

 380 

4.5.1. To compute the estimated binding free energies between ATP and wild-type/∆ELREA 381 

EGFRs, and between the activator and receiver kinases of wild-type/A702V EGFRs, use the 382 

molecular mechanics generalized Born surface area (MM-GBSA) module39 available in the 383 

AMBER package. Set ATP as the ligand and EGFR as the receptor in the ∆ELREA study. In the 384 

A702V study, specify the receiver kinase as the ligand and the activator kinase as the receptor.  385 

 386 

4.5.2. First prepare the ligand, receptor and ligand-receptor complex PDB files separately in 387 

the leap program setting the PBRadii value to mbondi2. For the PDB files, save the amber 388 

topology (.prmtop) and coordinate (.inpcrd) files.  389 

 390 

4.5.3. Then, in the mmgbsa input file, mmgbsa.in, set igb = 2, saltcon = 0.1. Execute binding 391 

energy calculations using the trajectories of the simulations, the prepared receptor/ligand 392 

amber files and the parameters in the mmgbsa.in with the MMPBSA.py script available in 393 

Amber as follows: 394 

$AMBERHOME/bin/MMPBSA.py -O -i mmgbsa.in -o mmgbsa.dat -sp X.prmtop -cp 395 

complex.prmtop -rp receptor.prmtop -lp ligand.prmtop -y prod.mdcrd -eo output.csv 396 

 397 

4.5.4. Analyze the output data, output.csv, by plotting graphs. 398 

 399 

REPRESENTATIVE RESULTS 400 

The described protocol was used to study the structural effects of the ∆ELREA and A702V 401 

mutations on the EGFR kinase structure. One application of the protocol was to investigate 402 

the effect of the mutations on local structural/conformational stability by computing RMSD 403 

and RMSF values from the MD simulations. As the A702V mutation is located at the 404 

juxtamemembrane B segment, the RMSD of this segment of the receiver kinase relative to 405 

the starting structure was calculated for both the wild-type and A702V EGFRs. The result 406 

(Figure 4A) revealed that the juxtramembrane B segment of the mutant has increased 407 

conformational stability during the 100 ns simulation (average RMSD 0.7 Å – 95% confidence 408 

interval (CI)  0.009) as compared to the wild-type EGFR kinase domain (average RMSD 1.1 Å 409 

– 95% CI  0.01). This is very likely the result of the tighter hydrophobic interactions at the 410 

dimer interface due to replacement of alanine 702 (methyl group side chain) to a bulkier 411 

hydrophobic residue, valine (isopropyl group side chain), leading to increased hydrophobic 412 

interactions of V702 on the receiver kinase domain with isoleucine 941 of the activator kinase 413 

domain.  414 

 415 

The ∆ELREA mutation is located at the β3-αC loop, adjacent to the functionally critical αC 416 

helix; the conformation of the αC helix is key to shifts between the active and inactive states 417 

of the EGFR kinase. The conformational stability of the αC helix in the active state was 418 

assessed by examining the RMSF over the Cα atoms of residues within the helix during MD 419 



simulations (Figure 4B): overall, there are lower fluctuations in the mutant (average RMSF 1.1 420 

Å – 95% CI  0.4) in comparison to the wild-type (average RMSF 1.5 Å – 95% CI  0.57); with 421 

the highest difference in fluctuations recorded for the N-terminal residues. The sampled 422 

conformations respectively superposed on the median structure of the wild-type kinase 423 

domain and of the ∆ELREA kinase domain also support these results (Figure 4C): both the 424 

wild-type and ∆ELREA kinase domains have overall similar stability for the superposed 425 

conformations except for the β3-αC loop and the αC helix, which are clearly more stable in 426 

∆ELREA EGFR. These findings indicate that deletion of the ELREA sequence restrains the 427 

movement of the active state αC helix, hence restraining and thus stabilizing the active 428 

conformation. Furthermore, since the αC helix forms part of the asymmetric dimer interface, 429 

the restraints on the αC helix in the mutant would very likely stabilize the asymmetric dimer, 430 

prolonging the duration of the activated state. 431 

 432 

Another application of the protocol is to investigate the behavior of key intra- and 433 

intermolecular interactions taking place during the simulation. Thus, the interaction between 434 

K745 and E762, which is fundamental to EGFR enzymatic activity, was analyzed for both the 435 

active form wild-type and ∆ELREA EGFR kinase by measuring the percentage occupancy of 436 

hydrogen bonds formed between the side-chain polar atoms of the two residues during the 437 

MD simulations (Figure 5A): this key electrostatic interaction was formed more often in the 438 

∆ELREA kinase domain in comparison to the wild-type kinase domain, owing to the more 439 

stable αC helix that accommodates E762. The interactions between Mg2+–ATP and the wild-440 

type and ∆ELREA EGFR kinase domains (Figure 5B) during the simulation were also assessed 441 

(Figure 5C): the number of hydrogen bonds were greater for ∆ELREA (average value 4.0 – 95% 442 

CI  0.03) than for the wild-type EGFR (average value 3.2 – 95% CI  0.04). Further analysis of 443 

the hydrogen bonds revealed that K745 interacts more frequently with the phosphate groups 444 

of ATP in ∆ELREA EGFR, which is linked to the more stable K745-E762 interaction noted in the 445 

simulation of the ∆ELREA mutant EGFR kinase domain. 446 

 447 

MD simulations as described in the protocol are also useful in assessing the relative free 448 

energy of binding for protein-protein and protein-ligand interactions. The binding energies 449 

between the activator and receiver kinase domains of wild-type and A702V EGFRs, and 450 

between ATP and the wild-type and ∆ELREA mutant EGFR kinase domains, were computed 451 

from molecular mechanics generalized Born surface area (MMGBSA) calculations (Figure 6A): 452 

the A702V mutant produced a lower average ΔGbind value (average ΔGbind = -76 kcal/mol – 453 

95% CI  0.47), representing more favorable dimer interactions, in contrast to the wild-type 454 

EGFR domain (average ΔGbind = -61 kcal/mol – 95% CI  0.61). This observation is consistent 455 

with the more stable juxtamembrane B segment and tighter dimer interface due to increased 456 

hydrophobic interactions observed for the A702V EGFR kinase domain. In the case of ATP 457 

binding to the wild-type and ∆ELREA EGFR kinase domains (Figure 6B), MMGBSA calculations 458 

predict stronger ATP binding with the ∆ELREA mutant (average ΔGbind -57 kcal/mol – 95% CI  459 

0.43) in comparison to wild-type EGFR (average ΔGbind -48 kcal/mol – 95% CI  0.33). This 460 

outcome is in line with the greater number of hydrogen bonds recorded between ATP and 461 

∆ELREA EGFR (Figure 5C) in comparison to the wild-type domain.  462 

 463 

The protocol can also be employed to investigate conformational changes observed during a 464 

simulation. In the current study, the effects of the ∆ELREA mutation on the inactive EGFR 465 

conformation was studied by visual inspection and superpositioning of the sampled 466 



conformations from the simulation. The analysis uncovered an inward movement of the αC 467 

helix in the ∆ELREA EGFR kinase domain (Figure 7A), a structural change expected during the 468 

transition to the active state. In contrast, the αC helix of wild-type inactive EGFR maintained 469 

its initial conformation (Figure 7B). Thus, the MD simulations support the proposal that the 470 

deletion mutation, shown experimentally to increase kinase activity40,41, promotes a 471 

conformational shift from the inactive kinase towards the active state. 472 

 473 

Table 1: Structures used to build composite models of apo active, apo inactive and ATP-474 

bound active structures. Missing regions (amino acid range in parentheses) in the principal 475 

structure were constructed from the listed structures. 476 

 477 

Figure 1: Structure of the EGFR dimer. EGFR dimerizes when the extracellular domains bind 478 

growth factor (EGF, epidermal growth factor). The receiver kinase domain is then activated 479 

through asymmetric interaction with the activator kinase domain, and the C-terminal tails are 480 

autophosphorylated at tyrosine residues (Modified from Tamirat et al.12). 481 

 482 

Figure 2: Location of an ErbB4 activating mutation and mutations producing kinase-dead 483 

ErbB4. (A) D595 (activating D595V mutation) is located on the aromatic/hydrophobic dimeric 484 

arms of the ErbB4 ectodomain model; the arms associate on growth factor binding; (nearby 485 

residues are shown as sticks). (B) In ErbB4, G802 (inactivating G802dup mutation) helps form 486 

the binding pocket around the adenine ring of ATP and catalytic D861 (inactivating D861Y 487 

mutation) binds both Mg2+ (not shown) and the γ-phosphate group of ATP. 488 

 489 

Figure 3: The asymmetric kinase domain dimer of EGFR. The A702V mutation would be 490 

located at the critical interface of the activator and receiver kinase domains, adjacent to the 491 

αC helix and close to isoleucine 941 of the activator kinase. Conformational changes induced 492 

by formation of the asymmetric dimer lead to kinase activation. The β3-αC loop containing 493 

the ELREA sequence directly precedes the αC helix; during activation, the αC helix moves 494 

inward towards the ATP binding site. 495 

 496 

Figure 4: Wild-type and mutant conformational stability of the active EGFR kinase domain 497 

during MD simulations. (A) RMSD (backbone atoms) over the juxtamembrane B segment of 498 

the wild-type (blue) and A702V (red) receiver kinase domain. (B) RMSF (Cα atoms) over 499 

residues of the αC helix: wild-type (blue) and ∆ELREA (gold). (C) Superposed sampled 500 

conformations of wild-type (left) and ∆ELREA (right) EGFR kinase domain; chain traces colored 501 

based on RMSD (Cα atoms) of each residue with respect to the median structure. Coloring 502 

ranges from blue to white to red, representing regions of high to low conformational stability. 503 

Note that the “free” N-terminal regions of the isolated kinase domain, colored red, would not 504 

exhibit this level of mobility in the intact EGFR structure. Figures adapted from Chakroborty 505 

et al.9 (Figure 4A reproduced with permission of the Journal of Biological Chemistry) and 506 

Tamirat et al.12. 507 

 508 

Figure 5: Key features seen in the active receiver kinase during MD simulations: the K745-509 

E762 salt bridge, the αC helix and interactions with. (A) Percentage occupancy of the K745-510 

E762 interaction during the simulation of the wild-type (blue) and ∆ELREA (gold) EGFR kinase 511 

domains. (B) Residues of the wild-type and ∆ELREA mutant interacting with ATP (sticks). Mg2+ 512 

(green) coordinates with ATP and D855. (C) The number of hydrogen bonds formed by ATP 513 



with both the wild-type and ∆ELREA EGFR kinase domains during MD simulations. Figure from 514 

Tamirat et al.12. 515 

 516 

Figure 6: Lower relative free energies of binding are observed for the mutant kinase 517 

domains during the simulations. (A) Binding energies calculated for the interaction between 518 

the activator and receiver kinase domains of the wild-type (blue) and A702V (red) EGFRs. (B) 519 

ΔGbind of ATP to wild-type (blue) and ∆ELREA (gold) EGFR kinase domains. Figures adapted 520 

from Chakroborty et al.9 (Figure 6A reproduced with permission of the Journal of Biological 521 

Chemistry) and Tamirat et al.12. 522 

 523 

Figure 7. Superposed conformations from the wild-type and ∆ELREA inactive EGFR kinase 524 

domain. Conformation of the αC helix and A-loop helix of (A) wild-type (median structure in 525 

blue) and (B) ∆ELREA EGFRs (gold). Other sampled conformations, faded white; initial 526 

structures prior to the MD simulations, pink. Figure from Tamirat et al.12. 527 

 528 

DISCUSSION 529 

The protocol described in this study focuses on using molecular dynamics simulations to 530 

investigate local and global structural alterations that arise from activating somatic mutations 531 

of the EGFR kinase domain. Although X-ray crystal structures of wild-type and mutant EGFRs 532 

provide invaluable structural insight, they depict one or a few static representations. 533 

However, inherent to the biological function of ErbBs is the necessary transitions between 534 

the enzymatically inactive and active tyrosine kinase, invoking dynamic changes in both the 535 

structure and intramolecular interactions between kinase monomers. MD simulations were 536 

thus carried out to probe the dynamic nature of the EGFR tyrosine kinase domain, including 537 

the wild-type structure, the introduced ∆ELREA deletion mutation, and the A702V mutation. 538 

These simulations were successful in elucidating the likely role of these mutations in the 539 

structures and how their effects on the conformation of the tyrosine kinase domain would 540 

lead to the experimentally observed increases in EGFR kinase activity. 541 

 542 

A crucial step in this protocol is the use of a relevant structure to assess the impact of the 543 

mutation. One way to select a relevant simulation input structure is to visualize the location 544 

of the mutation in the static 3D structure and examine its possible impact with respect to the 545 

neighboring amino acids and structural units. In this study, for instance, since the A702V EGFR 546 

mutation is located at the juxtamembrane B segment that forms the asymmetric dimer 547 

interface, the use of the dimer structure for the simulation as opposed to the monomer is 548 

critical. The use of a monomeric structure would have exposed the juxtamembrane B segment 549 

of the receiver kinase to the solvent, depriving it from the stabilizing interactions, enhanced 550 

by the mutation to a larger hydrophobic residue and interactions with isoleucine 941 from 551 

the C-lobe residues of the activator kinase. Moreover, it is noteworthy that the 3D structure 552 

represented by the coordinates in a PDB file do not necessarily correspond to the biologically 553 

relevant structure that should be used for study. For example, with the structure of ErbB4, 554 

PDB code 3BCE, the PDB coordinates correspond to a trimer, but this is due to crystal contacts 555 

(few contacts between the monomers are seen when visualizing this structure). Matrices 556 

within the PDB file can be used (e.g., within Chimera) to reconstruct the crystallographically 557 

related structures, which can be visualized to identify chains that correspond to the 558 

biologically relevant 3D structure as reported in the original publication42. Another essential 559 

step of the protocol is to properly prepare the simulation input structure, such as building 560 



missing amino acids in different loop regions, and especially where located in the vicinity of 561 

the mutation. Although numerous wild-type EGFR structures exist in the PDB, only a limited 562 

number of mutant EGFR structures are available. Consequently, the mutant structures also 563 

need to be modeled; for a single residue mutation like A702V, Chimera was used to mutate 564 

the residue; whereas, for the ∆ELREA deletion mutation, Modeller was used.  565 

 566 

The various parameters utilized in the simulation input files – for example, the number of 567 

minimization cycles, heating the system to the desired temperature in one go or instead 568 

heating slowly through several intermediate temperatures, the time period for the 569 

equilibration and for the production simulations – can be modified based on the molecule of 570 

study, the aim of the work and one’s own preferences. While carrying out MD simulations, it 571 

is also common to come across errors that can arise from the input files, issues related to the 572 

simulation software in use or even a user error. Hence, it is very important to understand the 573 

source of the errors by carefully examining any error messages. Most simulation programs 574 

have a mailing list where users can pose questions to the software developers and to other 575 

users by which most problems can be resolved. Additionally, user manuals provide significant 576 

assistance to understanding the details of the simulation protocol, including assumptions and 577 

limitations. Although MD simulation is an important tool to explore the dynamic properties 578 

of molecules, remember that computational results need to be carefully evaluated in 579 

conjunction with other sources of information to assess their validity. Whenever possible, 580 

work together with researchers that are experts on the proteins under study, especially 581 

where relevant wet-lab experimental studies are made, which serve to provide results for 582 

structural interpretation as well as to suggest experiments that may be made based on 583 

structural observations to test hypotheses. 584 

 585 

In this study, the protocol was effective in examining the dynamic structural impacts of the 586 

∆ELREA and A702V mutations on the EGFR kinase structures. The simulations revealed that 587 

∆ELREA restrains the functionally essential αC helix and promotes a conformational shift from 588 

the inactive kinase to a stabilized active kinase. The simulation results are independently 589 

supported by drug response data that demonstrated the effects of tyrosine kinase inhibitors 590 

on lung cancer cell lines having the ∆ELREA deletion mutation and wild-type EGFR, where 591 

greater inhibition by drugs recognizing the active kinase conformation was reported for 592 

∆ELREA than for wild-type EGFR12. With the A702V mutation, the MD simulations indicate, in 593 

comparison to the wild type, increased stabilization of the activator-receiver kinase interface 594 

as well as higher affinity of the activator and receiver kinase for each other, together 595 

supporting maintenance of the activated conformation of the EGFR kinase. The A702V 596 

mutation, located on the juxtamembrane B segment of the receiver kinase, would increase 597 

hydrophobic interactions with the activator kinase, functioning to prolong the duration of the 598 

activated state. The A702V mutation supports cell survival in the absence of growth factor 599 

and was identified in an in vitro screening for EGFR mutations9.  600 
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The discussion section present at the beginning of the protocol has now been moved to 
the Discussion. 
 
6. Please highlight 2.75 pages or less of the Protocol (including headings and spacing) that 
identifies the essential steps of the protocol for the video, i.e., the steps that should be 
visualized to tell the most cohesive story of the Protocol. Remember that non-highlighted 
Protocol steps will remain in the manuscript, and therefore will still be available to the reader. 
 
Parts of the protocol to be included in the video are highlighted in yellow. 
 
7. Please ensure that the highlighted steps form a cohesive narrative with a logical flow from 
one highlighted step to the next. Please highlight complete sentences (not parts of sentences). 
Please ensure that the highlighted part of the step includes at least one action that is written in 
imperative tense. 
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We have highlighted the protocol considering a cohesive narrative. Parts of a sentence 
are however highlighted in some cases to leave out unnecessary or contextual details 
for the video recording.  
 
Reviewers' comments: 
Reviewer #1: 
 
Manuscript Summary: 
The manuscript "Deciphering the Structural Effects of Activating EGFR Somatic Mutations with 
Molecular Dynamics Simulation" is not a interesting manuscript for publication. The idea to 
study two new mutation is interesting however there is lack of the deep interpretreation the 
data from MD. 
 
Major Concerns: 
The abstract has no information about the finding from this study. The proposal is not new. It's 
a trival method which can be following from any tutorial from internet. Characterization of 
interaction comparing between wildtype and mutants can be more details than described in the 
manuscript. 
 
JoVE articles are aimed to thoroughly discuss the method/protocol used in a study 
rather than the results, as stated on the journal’s page. Therefore, in the abstract and 
elsewhere we have focused more on how the described protocol can be used to study 
the structural impacts of mutations that have been published in detail elsewhere. 
Furthermore, since only representative results are discussed in the article, a more 
detailed analysis of the MD data has not been presented. 
 
Reviewer #2: 
 
Manuscript Summary: 
The authors have well drafted the manuscript entitled "Deciphering the Structural Effects of 
Activating EGFR Somatic Mutations with Molecular Dynamics Simulation". The authors have 
tried to reveal the structural impacts of the mutations in the EGFR protein. Though the script is 
interesting, it needs several modifications before accepting for publication. 
 
Major Concerns: 
The AMBER dynamics tool has its own protocol page at https://ambermd.org/tutorials/ How is 
your proposed protocol serve more significance than the existing? 
 
The AMBER webpage indeed describes several protocols that can be used to assess 
systems with molecular dynamics simulations. Here, we have tailored the protocol to be 
used to probe mutation-induced structural changes of the EGFR protein. Moreover, our 
protocol describes not only the step-by-step procedures of performing simulations with 
AMBER, but also properly preparing input proteins structures and analyzing the output 
data, which are key parts of the process. 
 
Minor Concerns: 
 
1. Why authors have highlighted few paragraphs in yellow? Does it mean that, it should be 
reviewed and it is not the clean copy? 
 
The yellow highlighted section of the protocol is the part that is going to be included in 
the video, as instructed by JoVE. 



 
2. The references for the last Table are missing. Authors should mention the reference of each 
software. 
 
The references for each software are already included in the main text. However, the 
journal does not require references to be included in the excel file containing the table. 
 
3. In the RMSD plot, the deviation in the mutation condition is lesser than the native. How does 
author see this? Explain 
 
As described on lines 368-377 of the manuscript, the lower deviation values recorded 
for the juxtamembrane segment of the mutant show that this segment has a higher 
stability in the mutant as compared to the wild-type EGFR. This results from the 
replacement of A702 in wild-type EGFR by valine in the mutant, which results in tighter 
hydrophobic interactions at the dimer interface that accommodates the juxtamembrane 
segment. 
 
4. What is the clinical significance of the chosen mutations? 
 
The ΔELREA mutation is one of the most common activating EGFR mutation that is 
widely implicated in non-small cell lung cancer. We have now included this information 
on lines 148-149. The A702V mutation was studied as it was identified in our previous 
study that screened somatic mutations of EGFR, and A702V was determined as a gain-
of-function mutation by the iSCREAM platform and reported in one cancer patient. This 
information is mentioned on lines 152-154 of the manuscript. 
 
5. Why authors have not attempted to compare the SNP and deletion mutation against native 
in a single graph plot? 
 
The data/variable being compared for the SNP and the deletion mutation are different. 
For instance, in Figure 4A we have compared RMSD for the SNP against wild-type, 
whereas in Figure 4B we have compared RMSF of the deletion mutant against wild-type. 
In Figure 6A we have assessed the free binding energy between EGFR dimers for the 
SNP Vs wild-type. In contrast, the binding energy in Figure 6B is between ATP and 
ELREA/wild-type EGFR. The variables being studied are different hence they were 
plotted in separate graphs.  
 
 
6. The hydrogen bonds in mutation condition is more than native condition. You mean 
mutation is more needed for the protein to maintain its secondary structure? 
 
No, in Figure 5A the percentage occupancy of hydrogen bonds formed between K745 
and E762 of the salt bridge are shown. In Figure 5C the number of hydrogen bonds 
between ATP and wild-type/ΔELREA EGFR formed during the simulations are plotted. 
The figure shows that the mutant EGFR makes more hydrogen bond interaction with 
ATP as compared to the wild-type. This was linked to the stability of the K745-E762 
bond in the mutant EGFR, which led to a more conserved interaction between ATP and 
K745. This information is present on lines 412-418 of the manuscript.  
 
7. Author might check few latest publications on dynamics simulations and mutations for 
linking genotype-phenotype 
(i) Genotype-phenotype correlation in 18 Egyptian patients with glutaric acidemia type I 



Genetic Epidemiology of Glucose-6-Dehydrogenase Deficiency in the Arab World 
(ii) Evolution- and structure-based computational strategy reveals the impact of deleterious 
missense mutations on MODY 2 (maturity-onset diabetes of the young, type 2) 
(iii) Extrapolating the effect of deleterious nsSNPs in the binding adaptability of flavopiridol with 
CDK7 protein: A molecular dynamics approach 
(iv) Path to facilitate the prediction of functional amino acid substitutions in red blood cell 
disorders - A computational approach 
 
We thank the reviewer for the kind suggestions and we will consider them in future 
studies. 
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